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Premessa

L’attivita di stesura del “Manuale/guida formativa operativa QGIS (3.x) utile
agli operatori e fruitori avanzati del paesaggio rurale e forestale” & stata
svolta nell’ambito della Convenzione del Comune di Acquapendente coniil
Dipartimento di Scienze Agrarie e Forestali (DAFNE) dell’'Universita degli
Studi della Tuscia, per lo svolgimento di attivita didattiche, formative e di
ricerca nellambito dell’intervento 5.1 “Formazione specifica e nuove
professionalita” del progetto TREVINANO RI-WIND CuUP
F44H22000680006, finanziato con NEXT GENERATION EU - PNRR-M1C3 -
MISURA 2 “Rigenerazione di piccoli siti culturali, patrimonio culturale,
religioso e rurale” —investimento 2.1 “Attrattivita dei borghi storici” - LINEA
“A”.

La presente attivita si inquadra all’interno del task 1 della predetta
convenzione “Predisposizione di materiale didattico riguardante il
paesaggio rurale e la viabilita forestale del territorio di Trevinano”.
Nellambito di tale task e del successivo task 2 “attivita formative - eventi
formativi stanziali e/o semiresidenziali con focus su aspetti Agrari,
Forestali, Bioenergetici, Ambientali e Paesaggistici” sono state articolate
quattro specifiche attivita:

1. 1121 e22maggio 2025 presso la Sala Riunioni della Riserva Naturale
Regionale Monte Rufeno, evento formativo “Laboratorio teorico
applicativo — La viabilita forestale e rurale”, strumenti e tecnologie
smart per la digitalizzazione e classificazione della viabilita rurale e
forestale multifunzionale, evento promosso dal Dipartimento
DAFNE dell’Universita degli Studi della Tuscia. Il programma ha
incluso una sessione teorica e due visite in campo nella Riserva
Naturale di Monte Rufeno e presso le altre aree rurali del borgo di
Trevinano. L’evento ha visto la partecipazione di studenti, tecnici e
operatori del settore.

2. 1121 e 22 giugno 2025 presso la Sala Chico Mendes (Orto dei Frati),
sede della Riserva Naturale Regionale di Monte Rufeno, evento di
alta formazione “L'effetto del cambiamento climatico e della
presenza delluomo in montagna sulla flora, fauna e paesaggio
agrosilvopastorale”, promosso dal Dipartimento DAFNE
dell’Universita degli Studi della Tuscia in collaborazione con il Club



Alpino Italiano — Tutela Ambiente Montano (CAI TAM). Il programma
ha incluso sessioni teoriche, momenti di confronto, visite guidate e
una passeggiata didattica nella Riserva Naturale di Monte Rufeno
con passaggio per lo splendido borgo di Trevinano. L’evento havisto
la partecipazione di studenti, tecnici, operatori del settore e
cittadini interessati alla tutela e valorizzazione del territorio.

3. Creazione della carta della viabilita forestale e rurale del
comprensorio del borgo di Trevinano — un progetto per conoscere,
valorizzare e proteggere il territorio. Si tratta di un database di
informazione territoriale messo a disposizione dei fruitori sul sito
internet dedicato RI-WIND.

4. Redazione di un manuale/guida formativa operativa QGIS (3.x) utile

agli operatori e fruitori avanzati del paesaggio rurale e forestale.

Tale output, preparato dal gruppo di lavoro del Dipartimento DAFNE

dell’Universita degli Studi della Tuscia, sara prossimamente reso

disponibile in versione pdf scaricabile.

L’attivita di cui al punto 4, oltre alla prima fase compilativa, ha previsto
anche una validazione di campo strutturata come azione formativa attuata
nell’attivita 1. Tale validazione & stata svolta in campo presso una dedicata
area di studio su cui i corsisti hanno operato seguiti dai docenti. L’area di
studio presenta un delicato equilibrio sorretto dal Comune di cui fa parte.
Acquapendente & infatti il Comune del comprensorio dell’Alta Tuscia
Laziale con il piu alto numero di abitanti e con i servizi di base ancora
operativi, servendo anche i Comuni circostanti. Il territorio aquesiano, in
particolare quello di Trevinano, € plasmato da una storia rurale e forestale
intimamente radicata nelle tradizioni, dimostrata dai segni di una
antropizzazione diffusa, tra i quali la viabilita. Tale rete di connessione € un
elemento peculiare e tangibile della struttura territoriale, testimonianza dei
collegamenti tra insediamenti e aree produttive anche del passato.

L’evoluzione degli ultimi 80 anni in Italia, e non solo, ha introdotto un
cambiamento profondo che ha visto un’evoluzione ambientale correlata
alla scomparsa di molte pratiche agricole. | cambiamenti sociali verificatisi
nel corso di meno di un secolo hanno determinato la riduzione delle aree
coltivate, favorendo la ricolonizzazione delle specie forestali e conducendo
i gestori del territorio alla scelta di rimboschire ampie superfici. Tale



approccio ha condotto alla formazione di sistemi forestali che presentano
un valore ambientale, sociale, economico e territoriale indiscutibile. In
effetti, gli aspetti che oggi caratterizzano questo territorio dell’Alta Tuscia
sono lo specchio locale di quanto & avvenuto nel nostro Paese.

In ltalia, dal secondo dopoguerra le aree rurali hanno affrontato
cambiamenti profondi e sostanziali. Il fenomeno che & stato chiamato
“esodo”, termine molto evocativo, ha interessato sia le attivita agricole
vere e proprie, sia il territorio. Zanini nel 1961 scriveva che questo
fenomeno era nel complesso salutare, perché rispondeva alle esigenze
dello sviluppo industriale e del settore terziario del Paese. Tra laltro e
necessario ricordare che il reddito agricolo era tra i pitl bassi, in ragione del
fatto che erano soggette a coltivazione anche zone dalla scarsa fertilita e i
sistemi tradizionali, come quelli latifondistici e mezzadrili, non erano in
grado di sostenere dignitosamente le famiglie contadine. Nonostante gli
interventi volti al miglioramento dell’agricoltura, anche sotto forma di
incentivazioni, e le intenzioni della riforma agraria a partire dalla meta del
secolo scorso permaneva ’aspirazione a migliori condizioni economiche e
ad un migliore riconoscimento sociale (Pampaloni 1976).

Questi fenomeni di carattere nazionale, e non solo, hanno avuto un
significativo riflesso anche nel complesso dell’area di studio. Nel territorio
insistevano numerosi poderi mezzadrili, alcuni dei quali oggi sono
ristrutturati e fruibili dai turisti, dove si praticava la coltivazione dell’olivo e
della vite, colture estensive di cereali e di prati pascoli per consentire
lallevamento di bestiame. Il bosco ceduo era relegato nelle zone che
proprio non potevano essere utilizzate a scopo agricolo. Era tuttavia
funzionale alla vita dei mezzadri che utilizzavano la legna per scaldare le
abitazioni e per cucinare. Un’attivita produttiva connessa alla gestione del
bosco ceduo era anche la produzione di carbone, che riforniva di energia
anche i centri abitati vicini. Questi territori, piuttosto isolati, inadatti ad una
agricoltura al passo con i tempi, furono progressivamente abbandonati.
Tuttavia, verso gli anni 60 del secolo scorso, proprio in ragione delle mutate
condizioni sociali, come conseguenza del progressivo abbandono, le
proprieta furono acquisite al demanio tramite U'Azienda di Stato per le
Foreste Demaniali, che inizid un’opera di rimboschimento con conifere
sugli ex coltivi, assicurando anche un’attivita di salvaguardia idrogeologica.
Nasce cosi una proprieta forestale estesa, che verso la fine degli anni
settanta del secolo scorso & acquisita dal Demanio Regionale per poi



essere inserita nel 1983 tra le Aree Protette della Regione Lazio conilnome
di Monte Rufeno.

Da un evento di enorme valenza sociale, come lo spopolamento di un
territorio fragile, si € generato, attraverso un virtuoso intervento pubblico,
qguella che oggi € conosciuta come la Riserva Naturale Regionale di Monte
Rufeno.

Le trasformazioni sociali ed economiche hanno generato significativi
cambiamenti nel paesaggio, nel modo di vivere il territorio da parte dei
residenti, ed hanno dato origine ad uninteresse turistico sfaccettato, molto
spesso legato ai servizi ecosistemici della foresta e alla produzione agricola
e zootecnica di prodotti locali. In Italia, si € assistito anche ad un ritorno
verso le zone rurali, verso cittadine o piccoli borghi, ritenendo di poter
condurre una vita piu ricca di valori spirituali, di sostenibilita, di rapporti
sociali piu autentici. Si sono innestati nel tessuto sociale locale anche
soggetti con un profilo socioculturale di tipo urbano, con stili di vita,
aspirazioni e valori diversi. Un altro aspetto importante € stato anche una
maggiore formazione degli operatori del settore primario che ha permesso
di realizzare iniziative innovative come agricoltura biologica, attivita di
agriturismo, trasformazione di produzioni locali, anche caratteristiche del
territorio.



Introduzione al
Manuale/guida formativa
operativa QGIS (3.x) per
operatori e fruitori avanzati
del paesaggio rurale e
forestale

Obiettivo generale

L'obiettivo generale del progetto
di origine e
nell'effettuare un censimento

consistito

della viabilita forestale e rurale,
utilizzando il territorio della
Riserva come caso di studio. In
effetti, lo studio della rete viaria,
come rete diconnessione, hauna
valenza in primo luogo
conoscitiva, di approfondimento
delle caratteristiche e
dell’estensione della viabilita
rurale e forestale. Essa
restituisce per gli amministratori
del territorio linterconnessione
della struttura territoriale,
rappresentando il mezzo di
accesso sia per le pratiche
gestionali, sia per la sorveglianza
e il presidio del territorio. Inoltre,
e infrastruttura basilare per la
fruizione turistica del territorio,
consentendo l'accesso alle
risorse naturali e paesaggistiche.
La digitalizzazione e la
classificazione  dei  percorsi
(strade, piste, sentieri) danno
luogo alla creazione di un

Sistema Informativo Territoriale

che affronta la rete viaria con un
approccio multicriterio, volto a
valorizzare i percorsi anche in
chiave turistica e a rendere gli
interventi di programmazione
della manutenzione pit semplici.
Il presente manuale operativo si
prefigge di fornire un supporto
conoscitivo e formativo sia per i
gestori sia per i fruitori del
territorio.

Obiettivo specifico

L’obiettivo specifico & stato
fornire una guida operativa,
passo-passo all’'uso di QGIS, per
leggere, interpretare e preparare
le cartografie utili a un fruitore
hobbistico o professionale del
territorio rurale e forestale, dal
reperimento dei dati (Catasto,
CTR, DEM TINITALY, OSM) fino ai
layout PDF (inquadramento su
ortofoto, CTR e planimetria
catastale) e alle analisi
(pendenze e statistiche zonali).
Tale versione del manuale &
impostata per chi possiede gia
conoscenze di base in ambito
GIS, quali sistemi di riferimento,
raster, vettori e
installazione/apertura software
QGIS.

QGIS e uno
potentissimo ed estremamente

strumento

ampioin cuiivariplug-in vengono



continuamente creati o}
aggiornati. Ci0 che viene
presentato in questa sede non ¢
quindi Uunica modalita possibile
per raggiungere gli obiettivi
prefissati, ma una delle
molteplici possibili vie, quella
che, in base all’esperienza, si
ritiene piu semplice e pratica. Il
consiglio piu importante che si
puo fornire in merito a QGIS, ¢ di
considerare l’aggiornamento
continuo con mentalita aperta,
studiando la miriade di tutorial
disponibili online. E essenziale
mantenere un uso regolare dello
strumento QGIS, come elemento
chiave per sviluppare familiarita
con questo potente applicativo.

La versione che ci sentiamo di
consigliare al 2025 € QGIS 3.xLTR
(qualsiasi LTR recente ¢
comunque valido).

Approfondimenti

ILGIS & nato come uno strumento
tecnico, complesso e
specialistico, destinato a
professionisti del territorio:
agronomi, forestali, urbanisti,
geologi, architetti, ingegneri
ambientali. Per decenni & stato
utilizzato principalmente in
ambito istituzionale o]
professionale per analizzare,
pianificare e gestire le risorse del
territorio, dai piani regolatori alla

pianificazione territoriale, dalle
reti idrografiche alle analisi
geologiche.

Oggi, grazie alla diffusione del
software open source e alla
straordinaria evoluzione delle
tecnologie mobili, il GIS ha
superato le barriere del mondo
tecnico e si € trasformato in uno
strumento accessibile, flessibile
e perfettamente adatto anche a
un pubblico di appassionati,
esploratori e utenti outdoor
consapevoli.

Software come QGIS, libero e
gratuito, rappresentano il punto
di incontro tra rigore scientifico e
semplicita d’uso. In pochi minuti,
anche un utente non esperto puo
scaricare dati geografici,
visualizzarli su mappe satellitari,
calcolare distanze e dislivelli, o
preparare un progetto da
consultare in campo tramite lo
smartphone, con app intuitive
come QField.

L’'universo  GIS, un tempo
confinato agli studi professionali,
€ oggi una finestra aperta sul
territorio per chiunque ami la
natura, ’escursionismo, la
fotografia paesaggistica, la
mountain bike o semplicemente
U'esplorazione.

Un escursionista, ad esempio,
puo utilizzare QGIS per
pianificare un itinerario in
montagna partendo da ortofoto e
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carte tecniche, calcolando le
pendenze e il dislivello tramite un
modello digitale del terreno
(DEM), per poi esportare il
percorso sul telefono e seguirlo
sulcampo con il GPS integrato. In
questo manuale diamo risalto

proprio a questo specifico
aspetto.
Allo stesso modo, un

appassionato di mountain bike
puo analizzare i sentieri sterrati
scaricando le mappe
OpenStreetMap, verificare le
difficolta in base alla pendenza
media dei tratti, e creare un
percorso alternativo che eviti
salite troppo ripide o tratti poco
percorribili.

Chi pratica pesca sportiva puo
impiegare il GIS per individuare i
corsid’acqua principali, le aree di
confluenza e i bacini idrografici,
combinando carte tematiche e
ortofoto per valutare accessi e
condizioni ambientali.

Un cacciatore o appassionato di
natura puo costruire un archivio
georeferenziato dei punti di
osservazione o delle tracce
faunistiche, aggiornandolo in
tempo reale dal campo.

Gli amanti della fotografia
naturalistica possono pianificare
sessioni di scatto valutando
esposizioni e ombre in base
all’orografia del terreno.

Appassionati di escursionismo o
utenti interessati a trekking di piu
giorni possono integrare dati di
rifugi, sorgenti e punti d’acqua
direttamente sulle proprie mappe
personalizzate.

La potenza di QGIS sta nel suo
essere un ambiente aperto e
modulare: lo stesso strumento
che un forestale utilizza per
delimitare una particella di taglio
puod essere impiegato da un biker
per calcolare il dislivello
complessivo di un itinerario, o da
un fotografo per georeferenziare
le proprie immagini. Tutti
possono creare le proprie
mappe, analizzare il paesaggio,
sovrapporre dati da diverse fonti
e trasformare il territorio in un
laboratorio personale di
conoscenza e pianificazione.

Grazie all’integrazione con app
come QField (ma ce ne sono
anche altre), il passaggio dal
computer al campo € immediato:
la mappa digitale diventa uno
strumento vivo, che accompagna
lUutente durante Uescursione,
registra nuovi punti, aggiorna
percorsi e consente di rientrare a
casa con un dataset preciso e
pronto per ulteriori analisi.

In questo modo, il GIS non & piu
solo un linguaggio tecnico ma un
mezzo di esplorazione e racconto
del paesaggio, un modo per unire
conoscenza, passione e



tecnologia nella scoperta del
territorio.

In conclusione, si puo affermare
che QGIS rappresenta
attualmente il ponte ideale tra la
cartografia professionale e l'uso
quotidiano del territorio da parte
di tutti.

Il valore di tale strumento non
risiede esclusivamente nella sua
capacita di calcolare coordinate
0 generare mappe, ma piuttosto
nella capacita di trasformare
U'esperienza diretta
dell’ambiente in informazione,
consapevolezza e curiosita per il
mondo che ci circonda.

1
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Preparazione del progetto

Creare un nuovo progetto

Da QGIS selezionare > Progetto >
Nuovo.

Il progetto deve essere salvato
immediatamente; Progetto -
Salva con nome... (Figura 1) in
una cartella dedicata (es.

ProgettoTaglio_Lazio/), con
sottocartelle \dati_raw\,
\geodata\, \output\pdf\,
\output\vet\.

(2 Progetto Senza Titolo — QGIS

Progetto ENLE ISR

Si raccomanda di evitare spazi
nei nomi dei file, ad esempio e
consigliabile
particella_forestale.shp e non
“particella forestale.shp”.
Inoltre, non utilizzare accenti od
apostrofi, quindi “viabilita.shp” e
non “viabilita.shp”

salvare

Layer Impostazioni _Plugi

Nuovo
Nuovo da Modello
Apri...
ApriDa
Apri Recenti
: Chiudi
{ [ saiva
3 Salva Con Nome...
Salva Su
Ripristina...
J Proprieta...
Opzioni di Aggancio...
Importa/Esporta

| £33 Nuovo Layout di Stampa...

2} Nuovo Report...

% Gestore dei Layout...
Layout
Modelli
Esci da QGIS

CtrlsN

Ctrl+0

Ctrl+S
Ctrl+Shift+S

Ctrl+Shift+P

Ctrl+P

Ctrl+Q

Figura 1: schermata del menu Progetto.
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Sistema di riferimento delle
coordinate (CRS) del
progetfo

L’area di studio e prova € stata
impostata nella Regione Lazio
nella quale & consigliabile
lavorare in ED50 / UTM zone 33N
(EPSG 23033).
sistema di riferimento nel quale

Questo & il

le Regioni/Province richiedono
usualmente gli allegati digitali,
come ad esempio shapefile. Ogni

Foto 1: paesaggio rurale e forestale del territorio di Trevinano

Regione pud adottare vari sistemi
di riferimento, in generale per
'ltalia si possono utilizzare: WGS
84 UTM zone 32N (EPSG 32632),
WGS 84 UTM zone 33N (EPSG
32633), Monte Mario/ltaly Zone 1
(EPSG 3003), Monte Mario/ltaly
Zone 2 (EPSG 3004).

Progetto > Proprieta... > SR ~»
cerca “23033 “»> OK (Figura 2)

Se vengono importati dati con
CRS differenti, gli strati devono
essere riproiettati in EPSG:23033

13
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prima di eseguire qualsiasi
analisi.

Per i dati raster, la riproiezione va
fatta dal menu raster > proiezione
> Trasformazione (riproiezione)
(Figura 3). Per gli shapefile &
sufficiente cliccare col tasto
destro sul file dal pannello dei
layers e scegliere “salva come”,
specificando che si vuole salvare

un nuovo shapefile con un

sistema di

determinato
riferimento.

Impostazioni di snapping e
digitazione

Progetto > Opzioni di aggancio...
> spuntare Abilita [’aggancio
topologico e aggancio alle
intersezioni (Figura 4).

E opportuno impostare una
tolleranza (es. 10 m in unita di
mappa) per layer vettoriali che
saranno creati (strade,

particella).

&4

Foto 2: Strada forestale camionabile secondaria



@ Progetto Senza Titolo — QGIS @ Propriets Progetto — SR

P Modifica Visualizza Layer ioni  Plugi
) Nuovo CtisN
Nuovo da Modello » el Q
Apri.. Cti+0
Apri Da » Sistema di Riferimento delle Coordinate -
€S 05
Apri Recenti > EPSG:6706 - RON2008 o
= EPSG:3003 - Monte Mario / taly zone 1 o
Chiudi EPSG25833 - ETRSEI/ UTM zone 33N EPSG25833. ]
EPSG:32633 - WGS 34/ UTM zone 33N : o
@ sava Cr+S EPSG:3857 - WGS 84 / Pseudo-Mercator EPSG:3857 o
[ Salva Con Nome... Ctrl+ShiftsS €PSG:32632 - WGS 84 / UTM z0ne 32N 2563262 o
Sahvasu " Nascondi SR sconsiglati
. Coordinate di Riferimento le 1D dell autorita. =
Ripristina:3 Corrego Alegre 1970-T2 / UTM zone 245 EPSG:22524
Corrego Alegre 1970-72/ UTM zone 255 95G:22525
| CR-SIRGAS / UTM zone 16N E9SG:5909
Opzioni di Aggancio... CR-SIRGAS / UTM zone 17N EPSGE910
(CROZET POSSESSION 1963 UTM SUD FUSEAU 39 IGNF:CROZ63UTM395
Importa/Esporta 4 CSG67 (1GN 1995) UTM Nord fuseau 22 IGNF.CE7TIGISUTM22
Bt i s 5 CSGAT L1ITM e 21N 9SG s
2 Nuovo Report... ED50 / UTH z0me 330 Ly S— A—?,
%) Gestore dei Layout... Propriets \‘4‘ -
*Unith: metrt
Layout » *Statico (s basa m un datum che & fissato suls TS
Modell , i I =
Esci da QGIS Ctri+Q ok || Avuda Apphca Auto

Figura 2: schermata della tabella proprieta

Progetto Modifica Visualizza Layer |mpostazioni Plugins Vettore Database Web Mesh MMQGIS SCP Progessing Guida
“ DBBRRK {300 Bumm Lg e EHOR &
— DEMto:
LLAYA N 1 FES " o : n-
@ Assegna proiezione...
¥ J Miscellaneous » | @ Estrai proiezione...
. . . > . N Extraction »
Conversion »

Layer [C]E)
RO TVE-BAD

2 Allinea raster...

Figura 3: schermata del processo da seguire per la riproiezione di un
raster

Q *Progetto Senza Titolo — QGIS
Modifica Visualizza Layer |mpostazioni Plu
" Nuovo Ctrl«N

Nuovo da Modello 4

Apri... Ctrl+0
Apri Da »
Apri Recenti »
Chiudi

A salva Ctrl+S

@ salva Con Nome... Ctrl+Shift+S
Salva Su »
Ripristina...

J Proprieta... Ctrl+Shift+P

Importa/Esporta »
13} Nuovo Layout di Stampa... Ctrl+P
(%) Nuovo Report...

Impostazioni di aggancio del progetto

\é VTutsitayer || Segmento (10 € |3/px ~ ||} ModficaTopologica || W Permett izone || Aggando

sezone || 3% Auto-aggando

Figura 4: schermata per stabilire le opzioni di aggancio per la
digitalizzazione



Realizzazione di un 1.2 Cliccare su Nuovo

elaborato cartografico e Nome: Catasto Agenzia
digitale interessante area Entrate
rurale o forestale e URL: incollare Uindirizzo

del servizio WMS ufficiale
(https://wms.cartografia.

Agaiungere il Web Map
Service (WMS) del Catasto
dellAgenzia delle Entrate

agenziaentrate.gov.it/ins

pire/wms/ows01.php)

1.3 Confermare con OK poi
1.1 Menu: Layer > Aggiungi layer > selezionare Connetti (Figura 5)
Aggiungi layer WMS/WMTS

Layer | Ordnelayer | Gruppidi tasseli @ Crea una Nuova WMS/WMTS Connessione x|
Catasto Agenzia Entrate Dettagli Connessione 2 h v
Connetti Nuovo @ Rimuovi | Nome |Catasto Agenzia Entrate] | sava
A WRL artografia o0 pho E
D Nome Titolo Ria ‘Astenticaatone L
* Nuvola di
# Punti Configurazioni | Base
Testo Scegh o crea una nuova configurazione di autenticazione
# Delimitato P = &
‘4 GeoPackage
Codifica Inmagine Le configurazioni memorizzano le credenziali ariptate nel database di
autenticazione di QGIS.
]
GPS
*
7y Spatialite ol
Titoli HTML
PostgreSQL Dimensione tasselo i
o Riferimento E
Ms sQL Richied: dmensione passo
#* Server b Avanzato -
Numero massimo di risultati GetFeaturelnfo
Oracle Opzioni WMS/WHMTS L
o Coordinate di Riferimento Spaziale >
"P Layer Virtuak WMS Modalta DPI tutto =
Lp ayes Vituale Usa la legenda WMS contestuale
Rapporto pixel tassell lato server WMTS | Indefinito (non scalato) -
SAP HANA - -
. - Numero massmo di risultati GetfFeaturelnfo | 10 s 3
Nome layer
B Tanaea la | RT 0 ity |
Carica come layer separati [ >
Seleziona i layer | oK Annulla Auto

Tear T ik Auto

Figura 5: aggiungere un layer WMS
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1.4 Selezionare i layer disponibili
(mappe e particelle) e cliccare su
Aggiungi (Figura 6). Il layer mappe
riporta i confini dei fogli catastali,
mentre il layer particelle, per

Foto 3: Tracciato forestale naturale con fondo terroso e copertura di
lettiera, riconducibile a pista camionabile

appunto, riporta i confini delle

varie particelle catastali.

A\Il layer particelle non si

visualizza se non con uno zoom di
almeno 1:4000.
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'] @ Gestore delle Sorgenti Dati | WMS/WMTS

- o X
1
[ srowser Layer | Ordine Layer | Gruppi ditasseli
\ ’ Vettore Catasto Agenzia Entrate -
Comnetti || Nuovo Modifica || Rimuovi | | caica | Salva
 Rester
[Q
A Mesh
B D Nome Titolo “ Riassunto =
N Nirola » 19 copyright Copyright(c)  Agenzia delle Entrate - Servizio di consultazione della cartografia catastale WMS. Le informazioni ...
# Punti 21 default default
» 11 fabbricati Fabbricati | fabbricati - € ciascuna porzione di essi che avendo caratteristiche architettoniche e costruttive p

Testo
# Delimitato

astralZo... Mappe

GHE
CP.CadastralPar... Particelle

1 province Province - Uffici

Codifica Immagine

r'h GeoPackage

i _ -
» OPS @ pnG () PEG

# Spatialite v Opzioni

Il layer contiene la rappresentazione dei bordi delle mappe catastali. Ciascuna mappa e etichett
|1 layer contiene le particelle catastali. Costituisce distinta particella catastale ogni porzione conti...
Il layer contiene la rappresentazione, a seguito di un processo di semplificazione, dei confini dell... |~

4 PostgresQL Dimensione tassello [

MS SQL

Richiedi dimensione passo |
# Server

- Oracle

* SAP HANA

ayer Virtuale

Nome layer Particelle/Mappe

WFS / 0GC
API -
Features

2layer selezionati

*

Numero massimo di risultati GetFeatureInfo U
Sistema di Riferimento delle Coordinate (8 disponbili) EPSG:6706 - RON2008 MIE
Usa la legenda WMS contestuale
Carica come layer separati
Chiudi | Aggungi ||  Auto

Figura 6: Aggiunta dei layer catastali e connessione al servizio WMS

Creazione dello shapefile
della particella forestale e
calcolo dell'area

2.1 Menu: Layer > Crea layer >
Nuovo shapéefile...
Salvare il file con il nome che piu
si  preferisce, ad
“particella.shp” (Figura 7)
e Tipo geometria: Poligono
e CRS:EPSG:23033

esempio

2.2 Disegnare la particella
e Attivare il layer
particella.shp
selezionandolo dal
pannello Layer

e Attivare la modalita

modifica  selezionando

I'icona della matita

e Selezionare Aggiungi
entita poligonale

e La digitalizzazione viene
eseguita

progressivamente i punti

selezionando

lungo i confini visibili nel
WMS catastale

e La chiusura del poligono
avviene tramite clic con il

tasto destro;
successivamente devono
essere  compilati  gli
attributi e confermato
con OK

e Salvare le modifiche e

disattivare la modalita di
modifica cliccando sul
della

simbolo matita

(Figura 8).
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| B Gestore della sorgente dati CtrisL o & .=
& Nuovo vettore GeoPackage... Ctrl~ShifteN

Aggiungi layer >
Includi layer e gruppi.. /7. Nuovo vettore Spatial e ..
! Aggiungi da un file di definizione del layer... @ Nuovo vettore temporaneo...
| & Copialo stile {2 Nuovo vettore GPX
’: Incolla lo stile G Nuevo Shapefile x
I 0 —
2 :::Tz:mpp Nome e e S
l = — - Codifica fie uTrF-8 -
| 19 Apritabella stribut] 10 o geometria Sroiges -
J Attiva modifiche Includi dimensione Z Includs valori M
Salva modifiche vet SR del progetto: EPSG:23033 - EDS0 / UTM zone 33N 1.
Modifiche in uso e e
Salva con nome... o
Sihacomefiledig| O [=cTest =
| C3 Eimin layer/grupg Lunghezza 80 | Precisione
Add to Frelds List
| £ Duplica s
Fissa la scala di vigit| Fields List
Imposta SR del/i lay, Nome Tipo, Lunghezza Precsione
loposta SR del pog id Integer 10
Layer Properties...
Filtra...
| ™ Etichettatura
| Remove Field
©2 Mostra nella Panor:)
| 00 Mostra tutto nela P SRl poicts g
'l ©2 Nascondi tutto dalla Pancramica I

Figura 7: Creazione di un nuovo shapefile poligonale per la digitalizzazione
della particella.

@ *Progetto Senza Titoko — QGIS

Progetto Modifics Yousizza Leyer Impostazions Blugins Vetigre Bustes Detabase Web Meh MMQGIS SCP Progessing Guids

= DPERRY OIS ALHPPF R,/ RELEOR GE¥IM-=-5 &-
aeV.Z2eBBd 1@ &k -9 maE o R AevAe-
N2 BBOIRBARFPS . H 2R - B ¥Me s PR XN
Q% B-&- & N-S5-G-5- > - RN ZOC G ame By 0 B oo
Loyer LT Q) pocicsta shp - At eleme v
ROV &G-F »

= VI Particelle E
3 Particella

Figura 8: attivazione modalita editing shapefile e digitalizzazione manuale
della particella forestale sulla base del layer catastale WMS



Foto 5: Pista forestale inerbita riconducibile a viabilita secondaria
trattorabile

2.3 Calcolare la superficie in e Espressione: $area /
ettari 10000
e Aprirelatabella attributi~> e C(Cliccando su OK la
cliccare su Calcolatore di superficie verra calcolata
campi automaticamente (Figura
e Creare un nuovo campo 9).
sup_ha
e Tipo: Numero decimale
(10,2)
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Q o
/2B

= g & A7 X

1234 v w £ 123

id

(@ particella_shp — Calcolatore di Campi

Aggioma solo gi element selezionat (0)
v Crea un nuovo campo

Crea campo virtuale
Nome campo in uscita sup ha
Tpo campo in usata
Lunghezza campo in uscita 10

1.2 Numero deamale (reale)
< | Predsione | 0

Espressione | Editor defle Funzioni

Aok Chmpo Gt

feature
geometry

Anndla || Appika Aluto

Figura 9: Calcolo automatico della superficie della particella in ettari

mediante calcolatore di campi.

Scaricare e caricare il DEM 10

m TINITALY

3.1 Scaricare il DEM

Scaricare i file GeoTIFF 10
m per Uarea di interesse
da qui
https://tinitaly.pi.ingv.it/

Download_Areal_1.html
| file vanno salvati nella

directory
dati_raw/TINITALY/, o in
una cartella definita
dall’utente.

3.2 Creare un mosaico (se si

hanno piu tile)

Menu: Raster > Varie -~

Crea raster virtuale
(VRT)...
Selezionare tutti i file

TINITALY -> confermare
con OK (Figura 10)
Salvare

geodata/dem_tinitaly.vrt

come



r—"

Database Web Mesh MMQGIS SCP Progessing Guida e

- Calcolatore Raster... b . - ~ e

1= fLNOR &g =
DEMEo3D R —

e @& @& Hoce et ot e s e b

Avolysi ato in questo PC 4 S SR
Projections

F = % A8 b sk bt 9 R b scrc e b e
Miscellaneous Crea raster virtuale.

Orare et o e ]
Extraction +| B Informazioni del raster... zl®
[———
Conversion »| Z Fondi.. e egons
4 Allinea raster... W, Crea (pi
Rl B—

| B8 Indice tassello... e ——]

e

Avaents | Esaps come rocesso S = ona s

Figura 10: Costruzione di un mosaico raster virtuale (VRT) a partire da piu
tile del DEM TINITALY.

N~ Cand

Foto 6: Tracciato forestale a fondo naturale, privo di opere permanenti
indicativo di pista trattorabile secondaria

e Menu: Raster >

3.3 Ritagliare il DEM sull’area di Estrazione >  Ritaglia

studio raster da estensione...

(Figura11)
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e Raster di
dem_tinitaly.vrt

e Disegnare l'estensione di
ritaglio sullo schermo

input:

Allinea raster...

11 Georeferencer...
DEMto3D »
Analisi >
Proiezioni 4
Miscellanea 4

v

Conversione

| ¥

7l R
.

e Mantenere la risoluzione
originale

e Output:
geodata/dem_tinitaly_cli
p.tif

m Database Web MMQGIS Processing Guida
¥ Calcolatore raster ..

00 .

,,.\12

i g

%] ox

Ritaglia il raster con maschera...

(@ Curve di livello...

Figura 11: schermata del processo da seguire per ritagliare il DEM

sull’area di studio

3.4 Riproiettare (necessario)
e Menu: Raster > Proiezioni
> Riproietta...
e CRSdipartenza (pertuttii
raster TINITALY): 32632

e CRS di destinazione:
EPSG:23033

e Output:
dem_tinitaly_clip_23033.

tif.

Agaiungere la Carta Tecnica
Regionale (CTR) via WMS
4.1 Layer > Aggiungi layer ~>
Aggiungi  layer WMS/WMTS
(Figura 12)
e Cliccare su Nuovo

CTR Lazio
specifico

e Nome: (nel

caso come

esempio applicativo, o di
altro contesto di
riferimento necessario)

e URL: incollare lindirizzo
del servizio WMS della
Regione
(Geoportale

Lazio
regionale -
https://geoportale.region
e.lazio.it/geoserver/ows).

e Connetti > scegliere i

layer di interesse
(geonode: CTR_10K) =~
Aggiungi.
/A Anche per la
visualizzazione della CTR

Lazio & necessario uno zoom
di almeno 1:20000 per
visualizzare il layer.



(Q Data Source Manager | Browser | WMS/WMTS X
[ sowser o
tayer | Ordinelayer | Gruppidimationele | Cerca Server
mpeios | cTR Lazio ~ |
 Raster | comnett || mMuovo || Modfia || Rimuovi | | caica || salva | Add Defauit Servers |
S/ D ~ Nome Titolo Riassunto £
2z Mesh y 17 geonode:CBLN_Zona_operatival CBLN - Zonao... Nessun riassunto fomito

» 19 geonode:COCT
geonode:CTR_10K

* Testo delimitato

<p>COC (Centro Operativo Comunal...

Centri Operativi...
Carta Tecnica R.

» 23 geonode:Cammino_Benedetto2 RCL Cammino ... Nessun riassunto fornito
~{" GeoPackage » 25 geonode:Cammino_Francesco RCL Cammino ... Nessun riassunto fornito
+ » 27 geonode:Chirotteri_agg_2021 Chirotteri <p>Il progetto ha inizialmente censito...
P » 29 geonode:Cinema_teatri_25833 Cinema eteatri  No abstract provided
79 SpatialLite » 21 aeonade:Comini CamnnFstensione Comuni_Camn i
Image Encoding
g PostgresQL
e PG (pnes (PG (O GIF (O TIFF () sV
i MssaL
Sistema di Riferi delle Coordinate (3 di
% Oracle
Dimensione mattonella |
DB2 ps2
* Richiesta dimensione passo J
m Layer virtuale Limite di elementi per GetFeaturelnfo 10 |
WGS 84 Cambia ... |
Usa la legenda WMS contestuale
Nome layer |Carta Tecnica Regionale (CTR) - Scala 1:10.000 - v. 1990
1layer selezionato
Mi;‘ ArcGIS Map Server
S | chiud || Acgiungi Aiuto

Figura 12: Connessione al servizio WMS della Regione Lazio per caricare la
Carta Tecnica Regionale (CTR) in scala 1:10.000.

Calcolare la pendenza e le
statistiche zonali
5.1 Creare la carta delle
pendenze
e Menu: Raster > Analisi >
Pendenza...
e lLayer di elevazione:
dem_tinitaly_clip_23033.
tif

e Scegliere “Espressa in
percentuale”
e Output:

geodata/pendenza.tif

5.2 Calcolare la pendenza media
e massima

Menu: Processi >
Strumenti di analisi raster

- Statistiche zonali

Raster di input:
pendenza.tif

Layer di zone:
particella.shp

Spuntare “Media e

Massimo”

Cliccare su Esegui. Al
termine
dell’elaborazione, i valori
calcolati (ad es. mean,
max) vengono aggiunti
automaticamente alla
tabella attributi della
particella (Figura 13).
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3 Anaiioter - Saiiche o
2 Strumenti I St
#s Progettazione Modello... CtreAltsG | | oo [l * Statistiche zonali
. " [
) Cronologia... Ctrl+Alt+H 3
s 9 ‘parscet_sho [956:2%033] % o
= Visualizzatore Risultati Ctrl+Alt+R £ i
Modifica Elementi Sul Posto ooty
9 Pendenza [EPSG:2203%
(e
Strumenti i Processing e
TERC) [Sr——
St ds e

» © Usati di recente
» @ Analisi di reti

» @ Analisi geomorfologica
Analisi rastes

VAo e rante dops Tessaone defagarims.
= Arotonda raster

Avanusto - | |Eseg come frocesso n Seve. Esegs awa vy

Figura 13: Calcolo delle statistiche zonali (media e massima) sulla
pendenza all’interno della particella forestale

P

Foto 7: Tracciato forestale non stabilizzato con fondo fangoso e

vegetazione densa, riconducibile a pista trattorabile secondaria

e Menu: Layer > Crea layer
> Nuovo shapefile...
(Figura 14)
Tipo geometria: Linea

e CRS:EPSG:23033

Digitalizzare /a viabilita
esistente

6.1 Creare un nuovo layer lineare
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1 @ Nuovo Shapefile X
Nome file ‘ ‘ -]
| codifica file |uTF-8 - |
| Tipo di geometria /" Linea - ‘
Indludi dimensione Z Indudi valori M
| EPSG:23033 - ED50 / UTM zone 33N v | &
New Field
Nome ‘ ‘
Tipo \ abc Testo = ‘
Lunghezza ‘80 Predisione ‘
Add to Fields List
Fields List
Nome Tipo Lunghezza
id Integer 10
Remove Field
oK |  Annula || Aut |

Figura 14: creazione di un nuovo shapefile lineare per la digitalizzazione
della viabilita esistente

6.2 Disegnare le strade

modifica
(matita) > Aggiungi entita
lineare (Figura 15)
Digitalizzare seguendo la
viabilita visibile sulla CTR
e sull’ortofoto

Attivare la

Compilare gli attributi >
cliccare poi su OK

Salvare le modifiche e
disattivare la modalita
modifica cliccando
nuovamente sulla matita

e chiudendo la modifica
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Progetto Modifica Visualizza Layer Impostazioni Plugins Vettore Raster Database Web MMQGIS Processing Guida

w DNEDERERRRY 2L/ HPPLAHGBRDRS &
RV Awm A/ 0G /% = @ 5
MHES'CS% ?\] %@qngaﬁ% - “é ;Ep’i un°_§12 thx 1|

Qe BG 8 %
Layer [2E3]
'\‘/L@'.Yen'_i‘ » i

7
¥ Carta Tecnica Regio...
¥ Google Satellite

Figura 15: Digitalizzazione manuale delle strade forestali sulla base della
CTR e dell’ortofoto.

Q Plugi Tom (120
T Vettore Roster Database Web Mesh | o LA 99

M Gestisci ed Installa Plugin...

934 voto(i), 2454825 download
#_ Console python Ctrl+Alt+P
Etichette openstreatmap, josm,

osm, processing,
download, overpass, pbf,
remote, osmdownload,
modeler

Maggiori informazioni homepage bug tracker
repository del codice

Bivariate legend
Datakxp
foglioMappale

Online Routing Mapper
Autore Etienne Trimaille
Versione disponibile (stabile) 2.4.1 aggiomato a
03/04/2025 10:59 ora
lagale Europa occidentale -

Profile Tool
Tile+

o

Figura 16: schermata del processo da seguire per Uinstallazione del Plugin
QuickOSM

6.3 Integrare con e Menu: Vettore >
OpenStreetMap (OSM) QuickOSM - QuickOSM...
e Menu: Plugin > Gestisci e e Chiave (Key): highway

installa plugin... > (Figura17)
QuickOSM > Installa
(Figura 16)



@ QuickosM X
BN preset mappe | I cuida su chiavevalore | | Ripristina
zﬁ Richiesta rapida Preset [Non obbiigatorio. Es: panetteria -
Chiave Valore Aggiungi Cancella
A ﬂ Richiesta di qualsiasi chiave ~ | Richiesta di qualsiasi valore v H & “ = ‘
guest_house - |
[ i osm handle
healthcare
7 . healthcare:speciality
Parametri hEIght
hgv

N : O conditi
1) Informazioni | ¥ Estensichgv:conditional - Solo caratteristiche selezionate
historic
Al 0sM obje¢ hoops - pnloaded.

| salvainterrogazione in un nuovo preset IE\ | Mostra richiesta |E \ P Esegue richiesta
w Storico Interrogazioni
o [>](8]
All OSM objects with the key 'highway' in [area visualizzata o I del layer are going to b e 1S
0%

Figura 17: Impostazione della chiave di interrogazione “highway” in
QuickOSM per U’estrazione della rete stradale da OpenStreetMap.

\V'Ca&1 ) Raster Database Web Mesh

a DXF Import/Convert B
Group Stats »
Analysis Tools »
Geometry Tools -

i Research Tools »

B Data Management Tools >

I3 QuickOSM >

MMQGIS SCP Processing Guida

e bLlOR e
Jabe ‘ @bg b
I Buffer...

@ Poligono convesso...
5 Differenza...

#® Dissolvi...

@' Intersezione...

2 Differenza simmetrica...
@ Unione...

#® Elimina poligoni selezionati...

Figura 18: Selezione dello strumento taglia dal menu Vettore > Strumenti
di Geoprocessing
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I gpeees )

() Sovrapposizione di vettori - Clip (Ritaglio)

Parametri Log
Layer in ingresso
\/" highway [EPSG:4326]
Solo elementi selezionati
Layer di sovrapposizione
(9 particella_shp [EPSG:23033]
Solo elementi selezionati
Ritagliato

[Crea layer temporaneo]

V| Apriil file risultante dopo I'esecuzione dell'algoritmo

* clip (Ritaglio)

- €9 5&

- €9 @%

Taglia un vettore usando le geometrie di un altro
layer poligonale. Solo le parti delle geometrie del
layer di ingresso che ricadono dentro i poligoni del
secondo layer saranno aggiunti al layer risultante.

Gli attributi delle geometrie non vengono modificati,

nonostante proprieta come area o lunghezza delle
geometrie saranno modificate dall'operazione di
ritaglio. Se queste proprieta sono memorizzate
come attributi, questi attributi dovranno essere
aggiornati manualmente.

0%

Annulla

Avanzato ~ | \Esegui come Processo in Serie...

| Esequi | Chiudi Aiuto

T T

Figura 19: Utilizzo dello strumento “Taglia (Clip)” per ritagliare la rete
stradale OSM sull’area della particella forestale.

e Valore: lasciare vuoto
(per tutte le strade).
Estensione

e Estensione: la mappa

corrente
Esegui la query

Verranno aggiunti i layer
con la rete stradale OSM.

e Menu: Vettore >
Geoprocessing > Taglia
(Clip) per ritagliare le
strade sull’area della
particella o del buffer
(Figura 18)

e Copiare/incollare it
risultato nel layer

viabilita.shp. (Figura 19)

Aqqgiungere unortofoto

come basemap (con

QuickMapServices e Google

Saftellite)

7.1

Installare il plugin

QuickMapServices

Menu: Plugin > Gestisci e
installa plugin...
Nella barra di
digitare:
QuickMapServices

ricerca

Selezionarlo e cliccare su
Installa plugin

Chiudere
gestione plugin.

la finestra di



Una nuova voce
comparira  nel menu
principale: Web >

QuickMapServices
(Figura 20)

4l Mesh MMOQGIS SCP Processing Guida

LM Open Data WMTS »
MetaSearch »
Q ap

- (9] ¥

Al
AC

Figura 20: Accesso al menu del plugin

DS @K % Z |
@ 2gis »
@ AutoNavi 4
b Bing >
& EsRi d’
@ GeoQ » B
G Google >
" Here WeGo »
o Mapbox >
@ NASA >

QuickMapServices per 'aggiunta di

ortofoto di sfondo come Google Satellite.

7.2 Abilitare i servizi aggiuntivi
(operazione necessaria al primo
utilizzo)

Per impostazione predefinita,
QuickMapServices mostra solo
un elenco limitato di mappe.

Per ottenere Google Satellite e
altri servizi aggiuntivi, occorre
abilitare le fonti extra:

e Menu: Web >
QuickMapServices >
Impostazioni...
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Nella finestra che si apre
occorre
scheda  Altro (More
services)

andare alla

Cliccare sul pulsante
Ottieni elenco completo
(Get contributed pack)
(Figura 21)

Dopo qualche secondo,
apparira un messaggio di
conferma che indica
avvenuto caricamento
delle fonti aggiuntive.
Chiudere lafinestra



BN Men v0GS SCP Pregesng Guide

LM Open Duta WMITS B 0%
Letssammch s 8led E % 2
€ D

<. | Atolied
D ¥l b g
A W
o GeeQ
G Google
o Here WeGe
[o
@ nNasa
* ConcDl
« BasemapAl
i Samen
B vses
& waze
® Yesdes
s 0m
W) Search NextGis QMS
D 294 %0 Semch

2 Set proper scae

@ arou s

@ QuickMapSenices Settings X

Genersl  Thes  AddEdtRemove  Visblty | More services

Attention!

Contrbuted services definiSons are provided ‘as &' and are not veldated by pupn authors. These are
roof-of <oncest and for testng only. Vet Nlton L/ /0me.nexian.om 10 834 New services. Use at your own
ekt

Get contributed pack

Save Acruda

Figura 21: Attivazione del pacchetto completo dei servizi basemap in

QuickMapServices mediante 'opzione “Get contributed pack”.

Da questo momento sara
possibile accedere a centinaia di
basemap, incluse Google, Bing,

Esri, OSM, ecc.

7.3 Aggiungere l'ortofoto Google
Satellite

e Menu: Web >
QuickMapServices >
Google » Google Satellite

e Lamappasatellitareverra
aggiunta
raster di

come layer
sfondo nel
pannello “Layer”.

Se il layer non & subito visibile,
verificare che sia in fondo
all’elenco nella legenda
(trascinare verso il basso sotto gli

altri layer vettoriali).

7.4 Uso pratico
Usare 'ortofoto come base per:

e verificare la
corrispondenza tra
confini catastali e realta

e controllare la copertura
vegetale

e digitalizzare strade e piste
forestali

. L’ortofoto resta un servizio in
streaming (non scarica dati sul
computer), quindi serve
connessione Internet attiva.

Creare un progetto per rilievi
in campo con QField

QField e un’app mobile
(disponibile per Android e iOS)
che consente di raccogliere dati

geografici in campo utilizzando il
progetto QGIS come base,
mantenendo simbologie, attributi
e layout di layer.

In questo caso, sara preparato il
progetto per:
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e verificare e aggiornare la
viabilita forestale rilevata;

e registrare le aree disaggio
per il rilievo
dendrometrico;

® aggiungere
nuove piste o tracciati

eventuali

non presenti su CTR o
ortofoto.

8.1 Creare i layer per il rilievo in
campo
Layer punti — Aree di saggio
e Menu: Layer > Crea layer
> Nuovo shapéefile...
e Tipo geometria: Punto
CRS: EPSG:23033

e Salvare come
“geodata/aree_saggio.sh
pH

Layer linee — Viabilita aggiuntiva

e Menu: Layer > Crea layer
- Nuovo shapefile...
Tipo geometria: Linea
CRS: EPSG:23033

e Salvare come
“geodata/viabilita_nuova.
shp”

8.2 Preparare il progetto QGIS per
QField
Salvare il progetto principale
e Menu: Progetto > Salva
con nome...

e Nome file:
“Progetto_Taglio_QField.
qu”

Verificare che tutti i percorsi

siano relativi
e Menu: Progetto >
Proprieta > Generale >
Percorsi dei dati

e Selezionare: Memorizza i
percorsi come relativi al

progetto

Questo garantisce che QField
riconosca correttamente i file sul
dispositivo.
Controllare i CRS
e Tutti i layer (particella,
DEM, viabilita, CTR, ecc.)
devono avere CRS
identico (EPSG: 23033).
e Evita layer in sola lettura
da servizi (WMS/WMTS)

! I WMS (CTR, Catasto,
ortofoto) servono solo come
riferimento, non saranno
modificabili in campo. Devono
mantenuti per la
consultazione, senza

essere
essere
impiegati come layer di lavoro.
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Figura 22: Verifica dei sistemi di riferimento e della struttura dei layer
prima dell’esportazione del progetto QGIS per l'utilizzo in QField.
8.3 Esportare il progetto per e Modificabile (es.

QField con plugin QFieldSync

e Menu: Plugin > Gestisci e
installa plugin... >
QFieldSync > Installa

Nella barra degli strumenti
apparira Uicona di QFieldSync.

e Cliccare su QFieldSync ~»
Configurazione del
progetto (Figura 23)

Scegliere per ogni layer:

e Solo lettura (es. CTR,

Catasto, DEM)

“particella”, “viabilita”,
“aree_saggio”,
“viabilita_nuova”)

e |mpostare la cartella di
esportazione (es.
C:\ProgettoTaglio_Lazio\
QField\)

e C(Cliccare su Esporta per
QField

Verra creata una cartella con il
file .qgs (progetto), i dati vettoriali
eraster.
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OGO Vettore Raster Database

Web MMQGIS Processing Guida
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» gura d g

Lo Preferenze

Figura 23: Apertura della finestra di configurazione del plugin QFieldSync
per la preparazione del progetto destinato all’app mobile QField.

(2 Configure Project for QField Synchronisation X
Layers
®
Layer “ k Geomet Action
1| aree_saggio_shp [1 | editing offiine v
2| Carta Tecnica Regionale (CTR) - Sc... (| \ nessuna azione v |
3| Google Satellite (] \nessuna azione v |
4| viabilita_nuova_shp ] \ediﬁng offline v |
5| viabilita_shp ] \ediﬁng offline v |
BaseMap | Offine Editng |
[ create Base Map
® Single Layer (O Map Theme
Layer -
Tile Size [1024 \
Map Units/Pixel ‘ 10.0 ‘
Unsupported layers
OK ] ‘ Annulla |

Figura 24: Selezione dei layer da includere nel pacchetto QField e
definizione della modalita di accesso (modificabile o in sola lettura).
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Figura 25: Creazione della cartella di progetto pronta per l'esportazione

Acouatezza VA

Foto 9: Ricevitore GPS portatile per navigazione satellitare,

georeferenziazione e acquisizione dati geospaziali

8.4 Copiare il progetto sul

dispositivo mobile (la procedura

pud cambiare in base al modello
di smartphone)
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ANDROID

e Collegare lo smartphone
al PC con cavo USB.

e Dalla memoria interna,
cercare la cartella:
/Android/data/ch.opengi
s.qgfield/files/QField/, Su

alcuni dispositivi  pud
trovarsi in
/Documents/QField/ o)
/Download/QField/

e (Copiare al suo interno
Uintera cartella esportata
(ProgettoTaglio_QField)

e Aprire Uapp QField sul
telefono > Apri progetto >

cerca e seleziona
“Progetto_Taglio_QField.
qgs”

i0S
e Collegare il dispositivo al
computer e aprire Finder
(macOS) o
(Windows).
e Selezionare il dispositivo

iTunes

> sezione File Condivisi >
QField.

e Trascinare dentro la
cartella
ProgettoTaglio_QField.

e Su QField (app mobile),
aprire il progetto
dall’elenco dei file locali.

Alternativa tramite Uapp File

e Caricare la cartella nel
cloud (iCloud Drive /
OneDrive / Dropbox)

e Sul telefono, copiare la
cartella dentro app File »
iPhone/QField/Proj/

e Aprire QField > Apri
progetto - ripercorrere il
path fino ad arrivare alfile
Progetto_Taglio_Qfield.q
gs.

I, Su iOS non e possibile
accedere al file system generale.

8.5 Rilievo in campo
Con QField e possibile:

e visualizzare la particella e
la viabilita esistente;

e aggiungere punti (aree di
saggio) direttamente con
il GPS;

e disegnare linee (nuova
viabilita o piste non
censite);

e compilare i campi
attributi (tipo, stato, note)
intempo reale;

e salvare le modifiche
anche offline.
Le modifiche vengono
memorizzate  all’interno  del
progetto, aggiornando
direttamente gli shapefile
associati.

Altermine delle attivita in campo,
la cartella aggiornata di QField
deve essere trasferita sul



computer tramite collegamento
del dispositivo mobile al PC.

8.6 Sincronizzare le modifiche su
PC
e Copiare la cartella
ProgettoTaglio_QField dal
telefono al computer
(sovrascrivendo  quella
precedente o salvandola
come nuova versione).

e Aprire il progetto con
QGIS desktop

| layer “aree_saggio” e
“viabilita_nuova” conterranno le
entita create in campo. Salvare e
continuare con le analisi o con la
preparazione del layout di
stampa.

9. Layout di stampa

e Menu: Progetto > Nuovo
layout di stampa...

e Nome:
01_Inquadramento_Ortof
oto

e Impostare il formato (es.
A4 orizzontale) (Figura 26)

Foto 10: Dispositivi mobili utili per la raccolta georeferenziata di dati

forestali, tracciamento viabilita e annotazione dirilievi in campo
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Figura 26: Creazione di un nuovo layout di stampa in formato A4
orizzontale per la produzione cartografica del progetto.

Strumenti principali:
e Aggiungi mappa >
disegnare il riquadro -

centrare la particella
(Figura 27)

Aggiungi barra di scala
Aggiungi freccia nord
Aggiungi legenda
Aggiungi etichetta (titolo)



Oggetti B

Proprieta dell'oggetto B
Dimensione Pagina
Dimensione | A4

Direzione | Orizzontale

Larghezza | 297.000

@ *Layout
Layout Modifica Visualizza QOggetti ECFINGEREECEY Atlante  Impostazioni
: | Aggiungi Mappa
BLRE "% a3ing Vene
| #4 Aggiungi Mappa 30
FCNCHG) p & OB | = Aggiungi immagine
] =]
7 Aggiungi Etichetta
.Hl..HPH..lu..lsd " ggr 9 ..F?O.I.\,...P?O...(,...FO‘O.Hl..‘
@ — i, Aggiungi Legenda
| 2 == Aggiungi Barra di Scala
Kol % Aggiungi Forma N
7]
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E\ E [ Aggiungi Nodo ,
| 1 Aggiungi HTML
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Figura 27: Menu per aggiungere nella mappa la barra di scala, freccia nord

e titolo.

Prima della stampa:

Impostare la simbologia (da QGIS
non dal layout di stampa):
bordo
riempimento trasparente
e Viabilita:
differenziate pertipo

e Particella: rosso,

linee

e Pendenze: scala di colori
graduata (se necessario)

e \Verificare che la scala sia
appropriata

(generalmente 1:5.000 o
1:10.000, per catasto
meglio 1:5000 o anche
1:4000)

Esportare in PDF
e Menu: Layout > Esporta
come PDF... (Figura 28)
e Disattivare Rasterizza
solo se necessario (in
presenza di trasparenze).

e Salvare in output/pdf/.
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Figura 28: Esportazione del layout cartografico in formato PDF tramite il

menu di stampa.

Layout consigliati:
01_Inquadramento_Ortofoto.pdf
02_Inquadramento_CTR.pdf
03_Planimetria_Catastale.pdf

Utilizzo di QGIS e QField per

pianificare un'escursione

Questa sezione ha lo scopo di
descrivere come utilizzare QGIS
per:

e individuare e pianificare
un percorso
escursionistico su
ortofoto e carta tecnica

regionale;

e valutare pendenze e
dislivelli tramite il
modello  digitale del
terreno (DEM);

e creare un layer vettoriale
del tracciato (shapefile o
geopackage);

® esportare un progetto
QField per supportare la
navigazione in campo

anche offline.

1) Individuazione del percorso
e Aggiungereilayerdibase:
e Ortofoto: usare
QuickMapServices >
Google > Google Satellite

e Carta Tecnica Regionale
(CTR): aggiungere Vvia
WMS (Geoportale
regionale, come descritto
in precedenza)

e OpenStreetMap (OSM):

riferimento  per

sentieri gia mappati, >

come



Web > QuickMapServices e Usare la combinazione di
> OSM > OSM Standard ortofoto + CTR per
distinguere vegetazione,

Identificare il punto di partenza e viabilita, creste, valli e
di arrivo: sentieri.
e ¢ possibile aiutarsi con i e |mpostare una
toponimi CTR o con punti trasparenza per la CTR
di riferimento  visibili (clic destro > Proprieta >
(parcheggi, rifugi, valli, Trasparenza ~30%) in
cime). modo da vedere l'ortofoto
Valutare visivamente il percorso: sottostante. (Figura 29)
(2 Proprieta layer - Carta Tecnica Regionale (CTR) - Scala 1:10.000 - v. 1990 — Trasparenza X
e w Opacita Globale

fi Informazioni J [30l0% @ |3 @

Valore NoDat:
’)\:\\ Sorgente alore flobata

Valore NoData non definito

: i Simbologia

Valore NoData aggiuntivo ‘

-', - Trasparenza Visualizza NoData come v

/o
4 Visualizzazione Opzioni di Trasparenza Personalizzate
“ Temporale Banda trasparenza | Nessuno -

l ) Lista Pixel Trasparenti
g ™ Elevazione

Da A Percentuale Trasparenza

a\ Metadati
.

Legenda

. Visualizza
==} e
B8 Tabelle Attributi

=T QGIS Server

QField

stle  ~ [ oK || Annala || Appica | Aiuto

Figura 29: Impostazione della trasparenza per la Carta Tecnica Regionale
(CTR) tramite il pannello delle proprieta del layer, sezione “Trasparenza”.

2) Creare lo shapefile del e Attivare la modifica
percorso (matita) e disegnare il
percorso cliccando lungo
e Menu: Layer > Crea layer il sentiero visibile su

- Nuovo shapefile... CTR/ortofoto.

Tipo geometria: Linea
CRS: EPSG:23033
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Usare il mouse o penna grafica
per seguire con precisione le
curve di livello o le tracce visibili.
Cliccare con il tasto destro per
chiudere la linea > compilare gli
attributi di base.
e Salvare le modifiche e
disattiva la modalita di
modifica.

3) Calcolare pendenze e dislivello

E bene assicurarsi di avere
caricato un DEM (ad esempio
TINITALY 10 m o altro raster
altimetrico).

e Aprire il Pannello Profili

altimetrici:
Menu: Vista > Pannelli >
Profili altimetrici

Selezionare il layer del
percorso
(percorso_escursione.sh
P)

e Impostare il raster DEM
come sorgente di
elevazione.

e Cliccare sullicona del
grafico > QGIS genera
automaticamente il
profilo altimetrico lungo il
tracciato.

e Dal grafico € possibile
leggere:

a. quota minimae massima

b. dislivello totale (somma
dei tratti in salita)

c. pendenza media.

4) Preparareil progetto QField per
Uescursione

Aggiungere un layer di punti
“waypoint”

e Menu: Layer > Crea layer
- Nuovo shapéefile...
Tipo geometria: Punto

e Campi: id_punto, nome,

descrizione

e Salvare come
geodata/waypoint_escur
sione.shp

e Aggiungere punti per
rifugi, fontane, incroci,
vette, parcheggi ecc.

Salvare il progetto

e Menu: Progetto > Salva
con nome... >
“Escursione_Monte_X.qg
2"

e \erificare in Progetto -
proprieta > Generale chei
percorsi siano in modalita

relativa.

Esportazione del progetto per
QField

e Plugin QFieldSync ~
Esportare per QField

e |Impostare come
modificabili:



percorso_escursione e
waypoint_escursione

Esportare nella cartella
QField/Escursione_Mont
e_X/

Copiare il progetto sullo
smartphone come fattoin
precedenza

5). In campo con QField

Con il progetto caricato in QField
e possibile svolgere le seguenti
operazioni:

Visualizzare il percorso
pianificato e la posizione
GPS in tempo reale.

Aggiungere nuovi punti
(waypoint) direttamente

sul terreno (es.
deviazioni, fontane,
rifugi).

Aggiornare o correggere il
tracciato in base al
sentiero effettivo.

Registrare note o foto
collegate ai punti o al
tracciato.

Lavorare offline, senza
connessione Internet
(tuttiidativengono salvati
localmente)
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